
Scoring Machine Software E309          Page 1 of 20 © mdbs 

SCORING MACHINE SOFTWARE 

(Version E309) 

Mark Buckley-Sharp 
March 2023 

Contents 
Licence...................................................................................................................... 2 

Features .................................................................................................................... 2 

Media ........................................................................................................................ 3 

Setting the Excel Security Level ................................................................................ 3 

Software Introduction ................................................................................................ 3 

Individual Events ....................................................................................................... 4 

Starting the Software ................................................................................................. 4 

The Options panel ................................................................................................. 4 

Configure Handsets ........................................................................................... 4 

The Actions panel .................................................................................................. 5 

The Reports Panel ................................................................................................. 5 

Save + Close: (button) ....................................................................................... 5 

Basic Scoring – Multi-Judging ................................................................................... 6 

Form Layout ....................................................................................................... 6 

The Basic Scoring Process ................................................................................ 6 

Scoring with Saving of the Individual Judge’s Scores ................................................ 7 

The Scores Worksheet .............................................................................................. 7 

Scoring Using an Integrated Entries List .................................................................... 8 

The Entries Worksheet ............................................................................................ 10 

Required columns ............................................................................................ 10 

Optional columns ............................................................................................. 10 

Column Order .................................................................................................. 11 

Event Title ........................................................................................................ 11 

Entries .............................................................................................................. 11 

Advanced Options for Entry Lists ..................................................................... 11 

Sorting before Scoring ...................................................................................... 12 

Scoring – Single Judge ........................................................................................... 13 

HeldBackImages Scoring Form ........................................................................ 13 

Entering Awards ...................................................................................................... 15 

Reporting:-  Score Sheet ......................................................................................... 17 

Reporting:-  Results Sheets ..................................................................................... 18 

Histogram Report ............................................................................................. 18 

Summary Report .............................................................................................. 18 

Detail Report .................................................................................................... 18 



Scoring Machine Software E309          Page 2 of 20 © mdbs 

Awards Report ................................................................................................. 19 

Appendix ................................................................................................................. 20 

Notes for programmers: ................................................................................... 20 

 

Licence 

The software is copyright. It may not be passed on or sold. Modifications become 
part of the original copyright. 

The software is licenced for free use by the Photographic Alliance of Great Britain, 
and by any of its member Federations and affiliated Clubs. 

Features 
All versions Number of judges 1-8 

Score range 2-5 or 1-5 
Visibility adjustment (0-4) of individual judge scores 
Testing Handset encoding 
Scoring Machine to accept individual judge scores and calculate the 
total 

E3xx Saving of the individual judge’s scores, not integrated with any entries 
list, for subsequent statistical analysis 
Integration with a list of entries to allow announcing of titles, and saving 
of scores 

E304 Preparation of a score sheet report for manual score recording, given 
an integrated list of entries 
Preparation of summary and detail results reports after scoring, given 
an integrated list of entries 

E305 Viewing of awards records with quick addition/editing of Awards, given 
an integrated list of entries 
Removed the advisory timer from the scoring form 

E306 A ‘Home’ button and an unscored entries count on the scoring form 
A Histogram result report showing the numbers of entries at each score 
level, with messages for any no scores or errors 

E307 Ability to use the system for manual recording of scores from a single 
judge. Scores can include half marks and entries can be held back for 
scoring later. Allows use of the same workflow for a single judge as for 
multi-judging 

E308 With multi-judge scoring, any hanset position (1-8) can be designated 
as an active judge, or as an inactive judge whose scores do not count 
towards the total for an entry, or as disconnected 

E309 The results include an additional sheet showing just the awards 
It is not possible to close the workbook without saving 
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Media 

Scoring_E309.xls   is an MS-Excel 97-03 workbook file, requiring availability of 
Microsoft Office Standard, or standalone Excel, version 2000 or later. 

Copy the file required to a convenient location eg, the desktop. 

Setting the Excel Security Level 

All Excel versions of the software contain code in Visual Basic for Applications (VBA), 
requiring a change to the default Excel security settings to allow the software to run. 
Open Excel, and set/check the Macro security level. 

In Excel-2000 do  Menu>Tools>Macro>Security... The installation default security 
level is ‘High’, which disables all macros. The security setting must be reduced at 
least to ‘Medium’, which will require manual acceptance of macros when the scoring 
software is opened. A setting of ‘Low’ allows the software to run without a warning. 

In Excel-2010, the security settings are in the Trust Centre under  enu>File>Options. 
Choose a suitable equivalent security level. 

Software Introduction 

The software  Scoring_E309.xls  is distributed as a workbook containing three 
worksheets: 

 Startup  contains an Options panel, an Actions panel and a Reports panel. 
The worksheet is protected from direct user changes during use. 

 Scores  may contain sample data for recorded scores. 

o A sheet with this name must be present when the scoring function 
within the software is started, where the option is set to record the sets 
of individual judge’s scores. 

 Entries  may contain sample data for a list of entries. 

o A sheet with this name must be present when the scoring function 
within the software is started, where the option is set to integrate with 
an entries list. And it must be present when any of the reporting 
actions are run. 

During use, additional report worksheets may be created: 

 Score-Sheet  contains a manual score sheet listing the entries. 

 Histogram  contains a histogram of the score results and any errors 

 Results-Summary  contains a summary of the total scores by entrant. 

 Results-Detail  contains a detail report by entrant of all entries with their 
scores. 

 Awards  contains an extract from the detail showing only any awards. 

All worksheet names are reserved. No worksheet may be renamed. At all times, and 
however many worksheets are in the workbook, the worksheets may be in any order. 
The worksheets are activated by name as and when required. 
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Individual Events 

Take a copy of the master file and rename for use with each event. 

In this specification, the individual event worksheet is referred to as ‘Event.xls’ 

Starting the Software 

Open the Event.xls file. The Startup worksheet is displayed. The option values are as 
saved from any previous use. 

Remove any sample data in Scores and Entries prior to adding live data. 

The Options panel 

Change the options only by using the buttons. Nothing can be directly entered on the 
sheet which is protected. 

 Configure Handsets: The configure handsets form is opened to set the 
judging mode, score range and handsets configuration. The current 
configuration is listed immediately below. 

 Score Visibility: Range 0-4. Default 2. Use the Decrease or Increase button 
to change the visibility level of the individual judge’s scores on the Scoring 
form. The new value is shown. This value is ignored when there is only one 
judge. 

o The visibility option is provided so that individual scores cannot be 
seen (visibility 0), or can only really be seen by the operator and not 
by any audience (visibility 1-2), or can be easily seen during private 
events (visibility 3-4). The total score is always highly visible. 

 Scores Recording:  ‘In Use’  or  ‘Not in Use’.  Default ‘Not in Use’. Use the 
Change button to swap. The current option is shown. 

 Entries List:  ‘In Use’  or  ‘Not in Use’.  Default ‘Not in Use’. Use the Change 
button to swap. The current option is shown. 

Configure Handsets 

The Configure Handsets form allows the following to be set. Each uses a combo box 
where only the listed options can be chosen. 

On opening the form, the values shown in the boxes are those currently saved in the 
system. 

 Judging Mode:  May be Multi-judge or Single-judge. For Single-judge, the 
remainder of the form can be set and the results can be saved, but none will 
have any effect when scoring in Single-judge mode. 

 Score Range:  May be either ‘1 – 5’ or ‘2 – 5’. This determines whether the 
‘1’ button an a handset is recognised as a score or an error. 

 Handset (1-8):  Each may be ‘Disconnected’, ‘Inactive Judge’ or ‘Active 
Judge’. Only handsets for active judges will count towards the score for an 
entry. A handset for an inactive judge may be used to allow a trainee judge to 
score and those scores can be saved for statistical analysis if Score 
Recording is in use. 

 Cancel:  The form is closed leaving the original settings unchanged.  
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 Set Defaults:  The option boxes are set to the system defaults of ,Multi-
judge’, score ‘2 – 5’, handsets 1-3 as ‘Active Judge’ and handsets 4-8 as 
‘Disconnected’. This is for display on the form only and does not modify the 
currently saved system settings. 

 Save:   

o As a validation test in Multi-judge scoring, there must be at least two 
Active Judges defined. Otherwise a warning is issued, the system 
defaults are set on the form, and the user must adjust and save as 
required. 

o On passing validation, the values currently in the option boxes are 
saved for use by the system. The Startup worksheet displays the 
options. 

The ‘X’ button to close the form is disabled with focus moved to ‘Save’. 

The Actions panel 

 Handset Testing  opens the handset testing form which allows testing the 
encoding for any handset. The form shows the graphic character entered, its 
ASCII value, and the decoded judge and score values. 

o Keys with a graphic, but which are not valid for scoring, show judge 
and score values of zero. 

o An inoperative key, or a key with no graphic eg, control and function 
keys on the normal keyboard, have no effect on whatever is already 
displayed. 

o Close the form using Return (or ESC, or the form’s ‘X’ button). 
o There may be a limit on the total characters which can be entered. If 

the display freezes, then close the form and reopen it. 

 Scoring  opens the scoring form, which is described below. For single-judge 
scoring, the action is prevented if an Entries List is not in use and any use of 
the Scores list is cancelled. 

 Awards  Opens the awards editing form, which is described below. The 
action is disabled if an Entries List is not in use. 

The Reports Panel 

 Score Sheet  Uses the data on the Entries worksheet to create a new Score-
Sheet worksheet with a printable manual score sheet of the entries in scoring 
order. The action is disabled if an Entries List is not in use. 

 Result Sheets  Uses the data on the Entries worksheet to create a new 
Histogram worksheet, a new Results-Summary worksheet, a new Results-
Detail worksheet and a new Awards worksheet. These are printable reports. 
The content of the results worksheets will only be relevant after scoring, 
where the scores are recorded on the Entries worksheet. The action is 
disabled if an Entries List is not in use. 

Save + Close: (button) 

The file should be closed using this button, which saves any changes to the options, 
scores, entries and any reports. 

If Excel is closed using its ‘X’ button, then the workbook is also saved. 
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Basic Scoring – Multi-Judging 

With both the ‘Scores recording’ and ‘Entries list’ options set to ‘Not in Use’, click the 
Scoring button on the Startup form. The Scoring form is displayed. 

Form Layout 

 The form title is ‘Scoring Machine’ 

 The next section, with ‘Seq’,’Ent’, ‘Title’, and’ Score’ boxes is unused, and a 
greyed message is shown for the Title. 

 The ‘Home’, ‘Previous’, ‘Next’ and ‘Next Unscored’ buttons are greyed. 

 The long ‘Data’ box is where the handset graphic characters are received. 

 There is space to show 8 judges, but only the connected handsets are shown. 
For each: 

o Active judges have their ‘Judge’ title in black. Inactive judges have 
their title in majenta. 

o The score box is zero until a valid score is received. 
o The flag colour is yellow. Other flag colours are described below. 

 The large ‘Score’ box is for the total. It is flagged yellow until a total is 
available. Other flag colours are described below. 

 The button labelled  ‘Return = Reset’  will clear the form. This button has 
other captions and functions, described below, where other options are 
chosen in the Startup sheet. 

 The button labelled  ‘ESC = Reset’  always clears the form. 

 The ‘Close’ button will close the form, and return to the Startup sheet. 

 The ‘X’; button is disabled with focus moved to the ‘Close’ button. 

The Basic Scoring Process 

For multi-judging, the judges use handsets. As the judges enter scores, characters 
from the handsets appear in the Data box. Valid scores are interpreted from the data 
and are shown against each judge using the current visibility level. Each judge is 
flagged with a colour code: 

 Yellow means no score has yet been entered 

 Green means a valid score has been entered, but the judge can still change 
the score. The score value is shown at the current visibility level. 

 Red is only used if the allowed score range is ‘2-5’ and the judge scores ‘1’. 
Red changes to Green as soon as a valid score is entered. Once the flag is 
Green, another invalid score of ‘1’ is ignored. 

The Total is flagged Yellow until all active judges are Green. Then the Total value is 
shown, and flagged Green. The Total value can change if an active judge then enters 
a different score. If any active judge scores ‘5’, then the total is flagged Cyan instead 
of Green. This may be needed if such items must be held back. 

Scores for inactive judges do not count towards the total. Failure of an inactive judge 
to score does prevent completion of the scoring cycle. 

The scoring cycle is completed when the operator decides to announce the Total, 
and uses  Return  on the keyboard, or clicks the  ‘Return = Reset’  button on the 
form, to clear the judges’ scores. 
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NOTE. Alternative actions for Return are described later. 

Using  ESC  on the keyboard, or clicking the  ‘ESC = Reset’ button on the form, will 
also clear the judges’ scores. 

Scoring with Saving of the Individual Judge’s Scores 

The Scores worksheet is described below. This section describes the difference in 
the scoring process when saving scores. 

When an entries list is also being used, then the scoring process follows that method 
(below), and saving scores is done as well. 

When saving scores is the only option, the scoring form looks exactly like the basic 
scoring layout, except that the Return button caption is  ‘Return = Save Score’. 

The entry of judge’s scores, the display of individual and total scores, and the colour 
coding of the flags is the same as for basic scoring (above). 

The scoring cycle is completed when the operator decides to announce the Total, 
and uses  Return  on the keyboard, or clicks the  ‘Return = Save Score’  button on 
the form, to copy the individual judge’s scores and the total to the Scores worksheet, 
and also clear the judges’ scores. 

Using ESC on the keyboard, or clicking the  ‘ESC = Reset’ button on the form, will 
clear the judges’ scores without saving them. 

The Scores Worksheet 

The various testing and scoring forms are modal and must be closed before 
accessing the Scores worksheet. 

No prior preparation of the Scores worksheet is required before using it with the 
Scoring form. 

When the Scoring form is opened with the Scores recording option set, then the 
Scores worksheet is checked. 

1. If the Scores worksheet is not found, then this is reported as an error. 

2. If there are a large number of rows already present, then this is reported as 
an error. 

3. If errors are reported, then the user has the option of continuing scoring 
without saving scores, or of closing the Scoring form to correct the errors. 

If there are no errors, then data is appended to any already present in the sheet. 

1. The first appended row shows column headers in bold. Column A: ‘Date’; 
column B: ‘Time’; columns C to J: ‘J1’ to ‘J8’; column K: ‘Total’. 

2. Subsequent rows record the date, the time, the individual scores and the total 
score, all each time a score is accepted on the Scoring form. Unused judge 
columns are left blank. Scores are not recorded if the Scoring form is reset 
using ESC, or when the Scoring form is closed. 

3. Recording stops when the Scoring form is closed. 

No analysis of the data is provided in this system. Analysis may require extracting the 
data into another system eg, another Excel workbook. 
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Scoring Using an Integrated Entries List 

Preparation and checking of the data on the Entries worksheet are described below. 
This section describes the difference in the scoring process when using an entry list. 

When the Scoring form opens for display, there are differences from basic scoring: 

 The form title will show the event name if that has been included with the 
entry list. 

 The ‘Seq’, ‘Ent’, ‘Title’ and ‘Score’ boxes are used, and the first entry will be 
displayed. The Title will be in all upper-case. 

o Normally, the entry will have a zero score, flagged Yellow. 
o If an entry is being rescored, it can have a non-zero score, flagged 

Green. 

 The ‘Home’, ‘Previous Entry’, ‘Next Entry’ and ‘Next Unscored’ buttons are 
available. 

 A ‘Currently Unscored’ box is visible and will show the number of unscored 
entries. 

 The Return caption is ‘Return = Save Score and Advance’. 

The entry of judge’s scores, the display of individual and total scores, and the colour 
coding of the flags is the same as for basic scoring (above). 

The scoring cycle is completed when the operator decides to announce the Total, 
and uses  Return  on the keyboard, or clicks the  ‘Return = Save Score and Advance’  
button on the form. 

 Normally, the currently displayed entry has a zero score (flagged Yellow). The 
total score from the judges is copied to the entry score (flagged Green) and to 
the Entries worksheet, there is a pause, and the next entry is displayed. 

 If the current entry has a non-zero score, and the judges new score is the 
same, then the new score is accepted, there is a pause, and the next entry is 
displayed. 

 If the current entry has a non-zero score, and the judges new score is 
different, then confirmation is requested. 

o The default confirmation is ‘No’. The form is reset and the entry does 
not advance. 

o The alternate confirmation is ‘Yes’. The new score replaces the old 
score, there is a pause, and the next entry is displayed. 

Using ESC  on the keyboard, or clicking the  ‘ESC = Reset’ button on the form, will 
clear the  judge’s scores, and the entry does not advance. 

 If the current entry has a non-zero score then confirmation is requested that 
the current score should be cleared. The default confirmation is ‘No’. 

Using Return on the keyboard or clicking the ‘Return= ‘ button on the form while 
there is no total judge score, will be treated as an ESC action, and the effect will be 
as above. 

After the last entry has been scored, there is an End of Competition warning, and the 
entry does not advance. 
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Move Entry Buttons 

At any time: 

 The ‘Home’ button can be used to return to the first item in the entry list. 

 The  ‘Previous Entry’  button can be used to reverse up the entry list, either to 
check data or to rescore an entry. There is a warning if the beginning of the 
list is reached. 

o No scores are recorded in the Scores worksheet (if that is in use). 

o The form moves to the previous record, except for beginning of list, 
without any saving or change of a score on the current record. 

o The form is reset for the displayed record. 

 The  ‘Next Entry’  button can be used to advance down the entry list. There is 
a warning if the end of the list is reached. 

o No scores are recorded in the Scores worksheet (if that is in use). 

o The form moves to the next record, except for end of list, without any 
saving or change of a score on the current record. 

o The form is reset for the displayed record. 

 The  ‘Next Unscored’  button moves down the list and stops at the next 
unscored item. 

o If the current item is unscored, then the same entry remains displayed. 

o If there are no more unscored items, then the last entry is displayed 
and there is a warning. 

o The form is reset for the displayed record. 

Skip Function 

There may be a reason why one or more entries in the list are unavailable for 
scoring. The operator has two options: 

 Click the ‘Next Entry’ button on the form (see above). 

 Provided that there is no other text in the Data field, the operator can use the 
keyboard to enter the skip command followed by Return, to skip the entry 
and advance to the next entry. 

o The skip command is the text   ##   (two hash characters), which is 
only relevant when working with entries. 

o If there is text in the Data field, then use the ESC key to reset the 
form without advancing. and then enter the skip command. 

o The effect of the Skip function is the same as ‘Next Entry’ (see 
above). 
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The Entries Worksheet 

The various testing and scoring forms are modal and must be closed before 
accessing the Entries worksheet. 

As distributed, the Entries worksheet may contain some sample data. Remove any 
sample data rows before entering real data for the event. 

The data may be edited as required. The data is only checked and used when the 
Scoring form is opened with the ‘Entries list’ option set to ‘In Use’, or the reporting 
functions are used. 

After scoring, the Entries sheet retains the scores alongside the original event data. 

No analysis of the data is provided in this system other than the available Reports. 
Analysis may require extracting the data into another system eg, another Excel 
workbook. 

Required columns 

Row 1 is required to contain the column headers. Certain headers are required and 
must be typed exactly as shown. 

 Seq 

o The data are numeric, giving the desired sequence order of showing 
entries from the Entrant. 

 Ent 

o The data are alphanumeric representing the Entrant, giving the order 
of showing entries within each block by ‘Seq’. 

o If the Entrants must be shown in a particular order, then the data 
should be numeric in the order required. 

 Title  The title of the entry. There is no specific limit on the number of 
characters. At least 60 characters can be displayed on the scoring form for 
announcement. Competition presentation systems may have different limits. 

 Score  The data is left blank when preparing the entries, and will be filled by 
the scoring process. 

Optional columns 

There may be any number of other column headers, for any data which may be 
required by the event. 

Some column header names are specifically recognised by the score sheet and 
results reporting functions.: 

 Entrant  Used for alphanumeric data where ‘Ent’ is required to be numeric. 

 Photographer 

 Award 

Other column headers with data may be included but will not be used during 
reporting. 

 Tie, Category, Nature, etc.  Fields specific to the sample event. 

Remove sample columns not required for the event, and add any that are required. 
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Column Order 

All the columns, required and optional, may be placed in any order. Although not 
ideal, there may be columns with no header. The software can skip across as many 
as four contiguous blank headers. 

Permitting any column order allows the user to match to an entry form. For example, 
it would be usual to put the ‘Score’ column at the extreme right as ‘Score’ would not 
be data typed from an entry form. 

Event Title 

Row 2 may optionally be used for the event title, and this title will be displayed during 
scoring. 

 The  ‘Sequence’  value must be  0  (zero) 

 The  ‘Title’  value is the event title. At least 60 characters can be displayed. 

 Any other data in this row is ignored. 

Entries 

The entries are typed in rows. The rows may be typed in any order starting in row 2 if 
there is no event title, or otherwise in row 3. 

There is no requirement to enter all the data at one time. The workbook may be 
saved and closed, and later reopened as required to edit or enter more data. 

Usually all the entries for one entrant will be typed sequentially. 

There is no requirement for ‘Ent’ numbers (if numbers are used) to be typed in a 
consecutive sequence. 

There is no requirement for all entrants to have the same number of entries. 

For initial readability, a blank row may be used between entrants. The software can 
skip across as many as four contiguous blank rows. 

While the most common use for the software will be where each entrant (Club, 
Federation, etc) provides a group of entries ordered by ‘Sequence’, other formats can 
be fitted. For example: 

 An event permitting one entry from each Photographer could use ‘Seq’=1 for 
all, and a unique ‘Ent’ value for each Photographer. 

 An event where the entries must be shown in an exact particular order should 
leave the ‘Seq’ column blank initially; sort the entries manually as required eg, 
by Title; and then fill ‘Seq’ as a numeric data series starting from 1. (Zero is 
reserved for the event title.) 

Before opening the Scoring form, where the ‘Entries list’ option is set to ‘In Use’, 
there must be a value for ‘Seq’ in every row containing data. Any row not containing 
a ‘Seq’ value will be ignored. 

Advanced Options for Entry Lists 

It is not necessary to type the data directly onto the Entries sheet. Data can be 
copied, and pasted into the Entries sheet. 

An entire sheet can be copied from another workbook and pasted in as a new sheet. 
The existing Entries sheet can be deleted, and the newly pasted sheet renamed as 
‘Entries’. 
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Sorting before Scoring 

The user is not required to sort the data on the Entries worksheet before scoring. 

The processes run before scoring are described here so that possible errors in data 
preparation can be avoided. These processes are run only when the Scoring button 
is clicked on the Startup worksheet to open the Scoring form, where the ‘Entries list’ 
option is set to ‘In Use’. 

1. A missing ‘Entries’ sheet is reported as an error. 

2. The columns are examined to ensure that all the required column headers are 
present. The reserved optional column headers are also recorded. Missing 
required column headers or duplicated required/reserved column headers are 
reported as errors. 

3. The total number of columns in use is evaluated up to and including the 
rightmost non-blank header. 

4. The rows are examined, using only the data in the ‘Seq’ column. The total 
number of rows is evaluated up to and including the last non-blank ‘Seq’ 
value. 

a. NOTE: To avoid this process losing control, there is a maximum row 
count of 1500. The maximum can be changed if required. 

5. Having no data below the header row is reported as an error. 

6. Given the total columns and total rows, the table of data rows is sorted, first 
on ‘Seq’ and second on ‘Ent’. A title row, with ‘Seq’=0, remains at the top. 

a. It follows that the user returning to the Entries worksheet after scoring, 
will find the data in the order of showing, and not in the order of data 
entry. 

b. The order of showing is in blocks by ‘Seq’, and within each block by 
‘Ent’. 

7. The number of non-blank rows is re-evaluated to eliminate any blank rows 
now sorted at the end. 

8. The title row (if used) is read to give the event title, which is displayed on the 
scoring form. Having no data below the title row is reported as an error. 

9. If there have been any errors reported during these processes, then use of 
the Entries worksheet is turned off. The user has the option of scoring without 
the list, or of closing scoring to correct the errors. 
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Scoring – Single Judge 

Manual scoring is available when there is only one judge and an Entries list is used 
for announcing. Judging handsets are not used. Any use of the Scores list is 
cancelled as the single judge scores are recorded on the Entries list. 

The Scoring form displays as for multi-judging except there are no boxes for the 
individual judge’s scores. 

Because an Entries list is used, the image title will be displayed and the buttons to 
move up and down the list are available if required. 

As the judge announces the score, the operator types that score followed by Enter. 

 Corrections can be made to typing by using backspace. 

 There is no particular score range limit. Half marks are allowed, typed as 
xx.5. Scores are rounded to the nearest half-mark. A valid score is flagged in 
green. 

 An image can be held back by typing ‘H’ (or ‘h’) followed by Enter. Any other 
data entered either before or after the ‘H’ is ignored. Holding back records a 
score of zero, flagged in cyan, leaving the image ready to be scored later. 

 If the image has been scored previously, then any change to that score 
requires verification. 

 Where ‘H’ is not used and the text entered is not a valid number then the 
data is ignored, the score box is blank and flagged red, and the entry does 
not advance. 

 The score form shows a running total of the number of unscored images 

On reaching the end of the competition, there may be unscored images held back, in 
which case a button is made visible to access the HeldBackImages form for easy 
scoring of those images. 

HeldBackImages Scoring Form 

The HeldBackImages form has: 

 A ‘Refresh List’ button 

 A ‘Close’ button 

 The ‘X’ button to close the form is disabled with focus moved to ‘Close’. 

 Up to 20 rows for display of unscored images, where each row shows the 
Seq, Ent and Title values, and there is a box to type the Score. 

 A ‘…more’ warning flag if there are more than 20 unscored images, meaning 
that some are not listed. 

The operator chooses the row according to the image being scored by the judge, so 
the judge can score in any order. The operator can tab down the score boxes in the 
rows, or can click into any score box. The operator enters the score, which must be a 
number with half-marks allowed. A score can be edited. 

The ‘Refresh List’ button will file any non-zero scores, with scores rounded to the 
nearest half mark, and redisplay the set of images which still have zero scores. 
Where this shortens the list, images which previously overflowed the form may then 
be included. 
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The ‘Close’ button will first refresh the list to file any non-zero scores and then check 
the residual count of unscored images. If there are any unscored images, then close 
of the form must be verified. It may be relevant to have unscored images if there are 
any disqualifications. 
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Entering Awards 

After scoring, awards can be added to the Entries sheet using the Awards edit form. 
Click the Awards button on the Startup form. 

The Awards form will only work if: 

 Scoring with an integrated Entries sheet is set in the Options. 

 The Entries sheet has the required column titles (Seq, Ent, Title and Score) 

 The Entries sheet also has the optional column for Award. 

 The Entries sheet has valid rows below the column titles and any optional 
event title. A valid row is one containing at least a non-zero value for Seq. 
Scoring could have proceeded, and awards can be allocated without data in 
the Ent column. Title data is optional, but desirable for manual data checking. 
Data for Score would be usual as awards are allocated after scoring. 

The form is displayed with: 

 Any available event title at the top 

 A table of existing awards, where up to 12 can be shown, and a message 
below the table will advise if there are more. The data in this table is not 
editable. 

 A row of data entry/display boxes for user input. 

There are two buttons on the form: 

 ‘Clear all’ will remove all existing awards and redisplay the awards table 
which will therefore have no entries. 

 ‘Close’ will close the form. All awards shown in the table are already saved. 

The row of data entry/display boxes comprises: 

 Seq: This is the starting box for data entry. Enter a value eg, from the manual 
scoring form. The value is not checked at this time. Proceed using the Tab 
key. 

 Ent: This is the second box for data entry. Enter a value eg, from the manual 
scoring form. Note that the value required is from Ent (a required column) and 
not Entrant (an optional column). Proceed using the Tab key. 

 Title: This will show the Title of the entry (if available) specified by Seq and 
Ent. This box is not editable. 

 Score: This will show the Score of the entry (if available) specified by Seq 
and Ent. This box is not editable. 

 Award: On entry to this box (from Ent), the rows in the Entries worksheet are 
searched for the previously entered values of Seq and Ent. The search is not 
case sensitive. 

o If the combined values are not found, then a message is followed by 
clearing the data entry boxes and a return to the Seq box. 

o On finding the matching row, the Title and Score boxes are filled, and 
the current award value is displayed in the Award box. The ‘Close’ 
button is disabled so that the form cannot be closed before any Award 
has been saved. An award may be added; an existing award may be 



Scoring Machine Software E309          Page 16 of 20 © mdbs 

edited; or an existing award may be deleted. Any text may be used. 
Proceed using the Tab key. 

 After tabbing from the Award box, the tab order returns the user to the Seq 
box. When the Seq box is entered with an Entries data row selected, the data 
in the Award box is used to update the Entries worksheet. Confirmation is 
requested if a pre-existing award is to be changed or deleted. 

 After any update of an award, the complete awards table is redisplayed, the 
‘Close’ button is enabled and the data entry/display boxes are ready to use 
again. 

 Although only 12 awards can be displayed in the table, there is no limit to the 
number of active awards which may be added. 

After completion of data entry, close the form using the ‘Close’ button. The ‘X’ button 
is disabled with focus moved to the ‘Close’ button if ‘Close’ is enabled. 
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Reporting:-  Score Sheet 

Click on the ‘Score Sheet’ button to create a manual score sheet from the content of 
the Entries sheet. 

Any previous ‘Score-Sheet’ worksheet is deleted and a new sheet created. The page 
layout is Landscape. 

The prior checks and sorting of the Entries worksheet data are the same as shown in 
the section above ‘Sorting before Scoring’. Steps 1-7 are run and any event title is 
recovered. The report is aborted on any errors. 

The columns on the score sheet are: 

 Seq (sequence number) 

 Ent (representing entrant) 

 Entrant (or no data is shown if the optional reserved column header is not 
found in the Entries worksheet) 

 a ‘|’ column separator 

 Title (with word wrapping to ensure no visual loss of data) 

 Photographer (or no data is shown if the optional reserved column header is 
not found in the Entries worksheet) 

 a ‘|’ column separator 

 Score (a box outline is shown for the cell) 

 Award (or no data is shown if the optional reserved column header is not 
found in the Entries worksheet) 

The rows are in the same order as used during scoring. 

The Score column boxes will be blank before scoring and filled after scoring. 

The Award column will show data if that has been entered on the Entries worksheet 
after scoring either manually or via the Awards edit form. 

The worksheet can be saved as a pdf (Excel 2010 and later), printed, or printed to a 
pdf writer for onward distribution. When output in print format, each page has a 
header of the event title and a footer showing the page number and total pages. 
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Reporting:-  Results Sheets 

Click on the ‘Results Sheets’ button to create a histogram report, a summary report, 
a detail report and an awards report from the content of the Entries sheet. 

Any previous ‘Histogram’, ‘Results-Summary’, ‘Results-Detail’ or ‘Awards’ 
worksheets are deleted and new copies created. The page layouts are Portrait 
except for Awards which is Landscape. 

The prior checks and sorting of the Entries worksheet are the same as shown in the 
section above ‘Sorting before Scoring’, except for the sort order. Steps 1-7 are run 
and any event title is recovered. The reports are aborted on any errors. 

The sort order is (1) Entrant (if available) or otherwise Ent, (2) Score, (3) Title. This 
places the data is blocks (ascending) by entrant, within which the Scores are in 
descending order, with Titles in ascending order for any same Score. 

Any of the report worksheets can be printed, saved as pdf (Excel 2010 or later), or 
printed to a pdf writer for onward distribution. 

Histogram Report 

The histogram report shows the numbers of scores for each score level in 
descending order. For multi-judging, the maximum and minimum for a valid score 
depend on the number of judges and on the score range chosen as options. For a 
single judge with manual scoring, the permitted range is 0.5 to 20. Scores outside the 
valid range are counted separately, especially any zero scores for unmarked. 

The main body of the histogram allows for up to 40 distinct score levels. 

If there are any errors, omissions or the histogram overflows, then messages are 
added below the histogram. 

Summary Report 

The summary report shows the event title and report name, followed by column 
headers. 

The columns are 

 Ent 

 Entrant (or no data is shown if the optional reserved column header is not 
found in the Entries worksheet) 

 Score ie, the total score for the entrant 

 Placing 

The row order is sorted in descending order of total score. The placings are 
calculated and added to the report, with any ties shown. 

Detail Report 

The detail report shows the event title and report name followed by the individual 
entrants in blocks. 

Each entrant block shows the Ent or the Entrant (if data available), followed by 
column headers and the data for that entrant. 

The columns are 

 Title 
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 Photographer (or no data is shown if the optional reserved column header is 
not found in the Entries worksheet) 

 Score 

 Award (or no data is shown if the optional reserved column header is not 
found in the Entries worksheet) 

The row order is descending by Score, with ascending Title for same score. 

The Score column boxes will be blank before scoring and filled after scoring. The 
Award column will show data if that has been manually entered on the Entries 
worksheet after scoring. 

The total score, as in the summary report, is appended to the end of each entrant 
block. 

Entrant blocks are paginated to minimise page overflows. 

Awards Report 

The Awards report is a subset of the Detail report showing only those rows with an 
Award. 

The columns are: 

 Title 

 Photographer 

 Entrant 

 Award 
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Appendix 

Notes for programmers: 

The scoring software has VBA code associated with the Workbook and the Startup 
sheet, with the five user forms (Awards, Config, HandSet Test, HeldBackImages, 
Scoring), and code in two modules. None of these can be copied between 
workbooks. 

The Startup sheet is protected from user input by a statement in the Workbook_Open 
routine. This can be commented out for maintenance, or use Review > Unprotect 
Sheet. 

The system options are stored on the Startup sheet in rows 23-24. The font is in 
white so that the values are invisible. The font colour is set in a Module 1 constant 
and can be changed if required for maintenance. 

There is no VBA code associated with the other worksheets. A replacement Entries 
worksheet can be copied in from another source if required. 

No software can be completely tested. While many possible errors have been 
anticipated with alerts issued, the VBA code may: 

 Produce an error message 

o Click debug and note the problem 

 Enter an endless loop 

o Abort Excel using the Task Manager 

o Open a blank workbook with Excel 

o Increase security level to turn off macros 

o Rerun the scoring software workbook and debug manually. 

Please report any errors found. 


